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Help Instructions

You can find information in Help by using the index or the Search feature. To return to the 
Help Index after you read the instructions below, click the Back button or press the B key.

* To use the Help Index, click an underlined topic, or press the TAB key until you 
highlight the topic you want. Then press the ENTER key.

* To scroll in the Help window, press the up and down arrow keys, or use the scroll bars 
with the mouse.

* To copy the information in Help to the Clipboard, Click on Help's Edit menu, then 
choose Copy. If you wish to copy the graphic elements in Help, press ALT+PRTSCR

* To return to the previous topic, click the Back button or press the B key.

* To open the Search feature in Help, click the Search button or press the S key.

* To close the Help window, click on Help's File menu, then choose Exit.



Eclipse Customer Support

If you need to contact our Support Service, be sure your registration card is filled out and on 
its way; then please follow these steps before calling. It will help us help you solve the 
problem faster.

1. Have a description of your hardware, including:

CPU type (286, 386, etc.)
hard drive and memory size
fax/modem board type
scanner and/or printer type
a list of any software or hardware that could affect Eclipse FAX, such as network 
boards/drivers

2. Have your Eclipse FAX registration number handy. You can find the number on the 
first page of the manual.

3. Jot down a complete description of the problem. If possible, include any steps taken 
before the problem occurred.

You can reach Eclipse FAX Support between 9:00 AM and 5:00 PM Central time, Monday 
through Friday. Or, you may write or fax us. Be sure to include all of the above information, 
as well as your name and address.

Eclipse Systems
33 West Monroe, Suite 1121
Chicago, IL 60603
ATTN.: Customer Support
(312) 541-0262
Fax: (312) 541-0514



Solutions to Common Problems

You receive the warning "Modem Communication Error"
You may have an address or interrupt conflict between your modem card and another 
device on your system (a scanner, mouse, network card, or sound board). If you run 
Eclipse FAX or Terminal and your mouse freezes, this means that your mouse is set to the
same interrupt as your fax modem. Remember: Even if your DOS terminal software 
works fine with the modem, your Windows terminal software and Eclipse FAX may not 
because the mouse is only active in Windows, creating the conflict.
This error may also mean that your fax modem is incompatible with Eclipse FAX, or it 
may be installed as the wrong class. Use the procedure below to identify your modem 
using the Terminal program.

You receive the warning "Cannot change modem parameters during 
communication."

This may mean that Eclipse Fax was installed for the wrong kind of modem. (Class 1 vs. 
Class 2) Skip this section if you have a CAS modem from Intel.

1. Find the Terminal icon in the Accessories Group and double click on it.

2. Tell Terminal which COM port your modem is using by pulling down the Settings menu
and choosing Communications. Use the scrolling list to choose the COM port. Click on 
'OK'. Type "ATZ<Enter>" on the Terminal main screen. If the modem responds, "OK", 
you know you've found the right port.

3. After you've received an "OK" response, type "AT+FCLASS=?" If it says, (0, 1), you 
have a Class 1 modem. If it says (0,2), you have a Class 2 modem. If it says (0,1,2), 
your modem operates as either Class 1 or Class 2. We recommend installing these as 
Class 1. If it says (0) or ERROR then you do not have an industry standard fax 
modem, and should purchase one.

IF YOU CAN'T USE YOUR FAX MODEM WITH THE WINDOWS TERMINAL 
PROGRAM, YOU WON'T BE ABLE TO USE IT WITH ECLIPSE FAX. TALK TO YOUR 
MODEM MANUFACTURER OR MICROSOFT TO GET YOUR MODEM WORKING WITH
TERMINAL BEFORE YOU CALL US.

You receive the warning, "COM Port Not Found or Unavailable." 
If you select the COM port you know your modem is on using Terminal and the Control 
Panel as described above and you get this message, this means another program is 
using the modem (e.g. a TSR in your autoexec.bat, a terminal program, or another fax 
program). Only one program can use a given COM port at a time. If you need to change 
the COM port Eclipse FAX is installed on, you can do this through the Windows Control 
Panel Printers application.

Eclipse FAX behaves erratically (sending and receiving at some times, failing at 
others), or your mouse freezes when you run Eclipse FAX.

You may have installed your fax modem on a COM port that already has a device 
assigned to it or your mouse may be set to the same interrupt as your fax modem. Check
your hardware configuration. If you are using Windows 3.0, be aware that you have 



shared interrupts on serial ports. This means that you cannot use a device on COM3 and 
COM1 or on COM4 and COM2. Windows 3.1 corrects this deficiency.

Sent faxes remain pending in the log. Status bar never appears.
This indicates that Eclipse FAX is having difficulty initializing the modem. This may 
indicate that you have chosen the wrong hardware selection, or that your fax modem is 
incompatible with Eclipse FAX. Try deleting all pending faxes, then re-starting Eclipse 
FAX.

You receive an error while trying to save a file, or when receiving faxes.
If you are getting errors in both these situations, it is likely that your disk is full. Fax 
images take up considerable space on a hard disk, so it is easy to fill your disk with old 
faxes. Delete some unnecessary files and try again. 

You receive an error while trying to open or view a file.
Generally, this means that the fax file has been corrupted in some manner. If you have a 
backup, open the backup file instead. Otherwise, have the fax re-transmitted.

When you send a fax using a calling card number, Eclipse FAX displays the 
message, "No Carrier." 

Verify that the phone number is correct. If so, try adding a comma or two between your 
card number and the phone number. This adds a pause after dialing the calling card 
number, allowing time for the phone network to respond.

Eclipse FAX does not connect when called by another fax.
or
Faxes are garbled.
or
Eclipse FAX does not send/receive faxes successfully.

Try sending or receiving from another fax machine. If this problem only occurs with a 
particular person or fax machine, it is possible that your fax hardware is incompatible 
with theirs. Also, check your E-FAX setup to make sure you have specified the correct 
hardware.

Custom cover sheets don't appear in the list of available covers when sending 
faxes.

If you created a new cover sheet with a unique name, this unique name will not appear 
in the list of cover sheets when sending. Instead, a new entry named 'Custom' will 
appear. See Creating Cover Sheets for more information.



File Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Open Opens a file on disk.

Open Indexed Uses an indexe to find a file. Once found you can open or delete it.

Open Phonebook Opens the Eclipse FAX phonebook.

Close Clears the current fax from the main program.

New Page Creates a new page for use as a fax coversheet, letterhead, or 
second sheet.

The following two menu items pertain to users of Polaris Software's PackRat information manager.
Find Fax in PackRat Searches PackRat's list of disk items.

Log in PackRat Logs the displayed fax as a Disk Item in PackRat.

Save As Saves a fax using a file name and format that you specify.

Save With Index Stores faxes with an index name in addition to of an eight-character
file name. More than on file can be saved under the same index.

Save Area Stores selected section of the current fax page.

Delete Deletes the fax that is displayed on your monitor from the hard 
disk.

Collect Pages Collecting allows you to attach several different faxes or images to 
each other to form a single fax.

Print Area Prints selected area of a fax.

Print Thumbnail Prints a thumbnail view of a multiple-page fax.

Print Prints the currently displayed fax.

Printer Setup Selects the printer you want to use for the output produced by 
Eclipse FAX.

Exit Exits from Eclipse FAX.



Send Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Send Fax Sends the fax that appears on your display.

Quick Note Quick Note sends just a cover sheet with a note.

Log Displays a list of faxes either sent or scheduled to be sent. Use the 
buttons at the bottom of the dialog box to view, re-send, delete, 
delete all, or print faxes.

Setup Send Setup customizes the way that Eclipse FAX works.

Status Displays the progress of fax transmission.

Manual Send Sends faxes manually.



Receive Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Log Displays a list of faxes received. Use the buttons at the bottom of 
the dialog box to view, re-send, delete, delete all, or print faxes.

Setup Receive Setup customizes the way that Eclipse FAX works.

Status Displays the progress of fax transmission.

Manual Receive Receives faxes manually. That is, you must answer the phone.



View Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Best Fit Displays faxes to fit the width of the screen.

Full Page Shows an entire fax page on the screen at once.

Dual Page On a multiple-page fax, shows two pages on the screen 
simultaneously.

Thumbnail View Activates the Thumbnail toolbar.

Reset Returns to the previous view, after using zoom.

ClearView Reprocesses fax image to make it easier to read.

Invert Changes the white areas of your fax to black and vice versa. 
Inverted faxes will print this way.

Rotate 0 Returns a rotated fax to its original orientation.

Rotate 90 Rotates the page to the right 90 degrees.

Rotate 180 Rotates the page 180 degrees.

Rotate 270 Rotates the page 270 degrees.



Page Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Next/Previous Skip back and forth in the displayed fax, one page at a time.

First/Last Skip to the first or last page.

Jump To Displays the page number specified.



Scan Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Scan to FAX Sends images directly from the scanner to the fax.

Scan to View Displays scanned images onto your screen. From there you can 
store, fax, or edit the images.

Scan to Printer Sends scanned images directly to printer. Lets you use your 
scanner as if it were a photocopy machine.

Scanner Setup Tells Eclipse FAX about your scanner.

Select Scanner Selects the scanner to use.



Tools Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Undo Reverses the last editing operation.

Redo Reverses the last Undo.

Erase Erases all the changes made during an editing session.

Hide Tool Bar Removes the toolbar from the display. (Changes to Show Tool Bar 
when selected.)

Bold Text Entered text will appear in bold.

Italic Text Entered text will appear in italics.

Black Pen Objects drawn with the drawing tools will be black. The current 
selection is preceded by a check mark.

White Pen Objects drawn with the drawing tools will be white. The current 
selection is preceded by a check mark. Check this option along with
Solid Objects, and you can draw white boxes over unwanted 
portions of your faxes (an eraser-like effect!).

Hollow Objects Objects drawn with the drawing tools will be hollow (transparent). 
The current selection is preceded by a check mark.

Solid Objects Objects drawn with the drawing tools will be solid (opaque). The 
current selection is preceded by a check mark.



Special Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Place Image Use this window to select part or all of a fax or picture file for 
placement on a fax.

Paste Pastes an image from the Windows Clipboard into your fax.

Select Selects part of a fax and copies it to the Windows Clipboard.

Select All Selects the entire fax and copies it to the Windows Clipboard. This 
is useful when you need a fax page transferred to another Windows
program that cannot load TIF or PCX files.

Merge Merges imported images onto a fax page.

Show Coversheets Displays a thumbnail view of all the available coversheets.

Rotate Pages Permanently rotates 180 degrees one or more pages of a fax.

Custom Images Calls up a list of previously saved custom images.



OCR Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

OCR File This command will OCR multiple page documents.

OCR Page This command will OCR the currently displayed page.

OCR Area This command allows you to OCR a small section of your fax 
quickly.

Select Zones Use this to draw a box around each element on the page that you 
want recognized.

Clear Zones This command de-selects the zones you have chosen, allowing you 
to start over.

OCR Zones Begins the OCR process on the selected zones. The program will 
follow the numbered order of the zones as displayed.

OCR Setup Displays the OCR Setup dialog box.



Help Menu
You may find more information on these menu items by searching for them as topics using search on the Help 
toolbar.

Help Index Displays the opening Help screen.

Menu Commands This will display a list of all available menus and commands in 
Eclipse FAX.

Glossary The glossary brings up a list of terms and definitions.

Using Help This will start the Windows Help tutorial.



The Toolbar

The Toolbar provides a quick, easy, and accessible way to use most Eclipse FAX options.
Actually Eclipse FAX has three toolbars. These are:

the View Toolbar
the Edit Toolbar
the Thumbnail Toolbar

An additional toolbar, the OCR Toolbar appears when OCR is used. The OCR toolbar is used 
to work with text after the OCR process is complete.

The View Toolbar and Edit Toolbar both give you a tool for "zooming in" or magnifying part of
a fax. Use this feature by drawing a box around a portion of your fax to enlarge it. This 
function is automatically available when the View Toolbar is active. If the Edit Toolbar is the 
active toolbar, click on the  button. (After examining the area, use the spacebar or 

 to return to actual size.) You can't zoom in on a fax if the Thumbnail Toolbar is active. 

Some of the icons on these toolbars appear on every toolbar; they are:

View

Edit Thumbnail

Thumbnail

Send Fax

ClearView

Undo

Redo



The View Toolbar

Use the buttons on this toolbar to look at your fax in a variety of ways.

View

Edit Thumbnail

Thumbnail

Send Fax

Page Turning

Jump-to-Page

Quick Page Selector

Page Rotation

Best Fit

Full Page

Dual Page

Return to Previous

QuickRead Forward

QuickRead Backward

ClearView

Undo

Redo



The Edit Toolbar

Use the buttons on this toolbar to modify both the text and graphics on your faxes.

View

Edit Thumbnail

Thumbnail

Send Fax

Page Turning

Zoom

Draw

Line

Ellipse

Rectangle

Text

Typeface

Type Size

Return to Previous

ClearView

Undo

Redo



The Thumbnail Toolbar

Use the buttons on this toolbar to display and manipulate miniature versions of your fax 
pages. This toolbar also contains a button for displaying the Collect Pages dialog box.

View

Edit Thumbnail

Thumbnail

Send Fax

Page Turning

Jump-to-Page

Quick Page Selector

Select Page

Swap Pages

Overlay Pages

Insert Page

Delete Page

Collect Dialog

Return to Previous

ClearView

Undo

Redo



The OCR Toolbar

The OCR toolbar appears at the top of the Edit window. It contains icons used for 
manipulating text.

Open File

Save File

Print File

Undo

Cut

Copy

Append

Paste

Find

Replace

Stop



Setting up Eclipse FAX for Sending Faxes

Once you have installed the program, you must configure Eclipse FAX for use on your 
computer. You can change these settings any time, just by following this procedure again.

Pull down the Send menu and click on Setup. The Send Setup dialog box appears. Complete 
the information in the dialog box using the information shown below. Eclipse FAX includes 
preset default values that work in most cases.

New Page Paper Size
Send Resolution
Detect Dial Tone
Tone/Pulse
Show Fax Status
Wait for Connect
Local Prefix
L. D. (Long Distance) Prefix
Speaker
Speaker Volume
Max. Retries
Retry Time
Max. TX Rate
Min. TX Rate
Home Area Code
Current Area Code
Modems...

For more information on making Eclipse FAX work with your modem, see the Solutions to 
Common Problems topic.



Setting the Receive Options

Use this procedure to tell Eclipse FAX how to receive your faxes. This includes whether or not
to receive them automatically.

1. Pull down the Receive menu and click on Setup. The following dialog box appears.

2. Select the options you want.

Notify on Reception
Print on Reception
OCR on Reception
Show Fax Status
Automatic Reception
Rings Until Answer
Fax Forward

NOTE:
If you have a CAS fax board, such as the Intel SatisFAXtion, the 'Automatic Reception' option 
will not appear. These fax boards will always receive automatically in the background.



Setting Up and Changing the Fax Banner

The fax banner is the small type printed at the top of each page of your fax. Use this 
procedure to specify what and where information should appear in the banner. Of course, 
you can decide not to include a banner on your faxes. You can have several different text 
selections in each banner item. This would be useful if you have several companies or 
individuals using the same computer to send faxes.

If the Send Fax dialog box is not already on your screen, pull down the Send menu and click 
on Setup. Complete the information in the dialog box using the information shown below. 
Eclipse FAX includes preset default values that work in most cases.

From Name
From Co.
From Fax
From Voice
Station ID
Page Number
Date/Time
To Name:
To Co:

Click on the  button to record your entries. Eclipse FAX returns you to the 
main screen. If you want to enter additional banner items or select new items, return 
to Step 1. When the Setup dialog box appears again, the last items entered appear in
the fields.

NOTE:
If you have a CAS fax board, such as the Intel SatisFAXtion, some of these options will not 
appear. These options are set in the CASMGR setup program.



Installing Your Scanner

Use this procedure to tell Eclipse FAX about your scanner.

1. Pull down the Scan menu and click on Select Scanner. A dialog box appears listing the
scanners that Eclipse FAX supports directly.

2. Select the scanner you plan to use. If you do not see your equipment listed, check 
the user manual for your scanner. It may be compatible with one of the scanners 
listed. If you are still unsure, select HP ScanJet Plus. This works in most cases.

3. Click on the  button. Then click on the 
 button.

4. Pull down the Scan menu and click on Scanner Setup. A dialog box appears.

5. Change any of the entries on the dialog box as needed. Refer to your scanner's 
documentation for details on these settings.



Eclipse FAX Settings in the E-FAX.INI File

The Eclipse FAX Manager stores information about the location of its program files, fax 
storage directory, and other user choices in the E-FAX.INI file. Whenever you change any of 
these settings, the new selection is saved in E-FAX.INI. This is a sample of some of these 
entries:

[ECLIPSE]
Program Directory=C:\EFAX
Send Log=C:\EFAX\send
Receive Log=C:\EFAX\receive
Save Images=C:\EFAX\images

You can use Windows Notepad or Write to edit E-FAX.INI; however, if you choose to use Write
be sure to save the new version as "Text Only."

If you wish to automatically start up Eclipse FAX when you start Windows 3.0, add the 
following line in the [Windows] section of your WIN.INI file:

LOAD=C:\EFAX\E-FAXMGR.EXE

If you wish to automatically start up Eclipse FAX when you start Windows 3.1, simply drag 
the Eclipse FAX icon to the program group 'Startup', then restart Windows.



Creating and Using Phonebooks

Use this procedure to create new phonebooks or delete existing ones.

1. Pull down the File menu and click on Open Phonebook. The Phonebook dialog box 
appears.

2. At Title (in the Phonebook section), select an existing phonebook from the list. Or 
type the name of the new phonebook.

3. To add a new, blank phonebook, click on the  button. Eclipse FAX adds a
new phonebook with the name that you entered in the Title field. To change the name
of an existing phonebook, select the name and edit it. Then click on the 

 button. To delete the selected phonebook, click on the 

 button. Eclipse FAX removes the selected phonebook from its list of 
phonebooks.



Modifying Existing Phonebooks

Use this procedure to add, change, or delete names in an existing phone book.

1. Pull down the File menu and click on Open Phonebook. The Phonebook dialog box 
appears.

2. Complete the fields in the dialog box as needed.

Name
Company
Fax
Voice
Phonebook Notes

3. To add this name to the current phonebook, click on the  button. To 
modify a current listing, click on the 

 button. To clear the fields without affecting the phonebook, click on the 

 button. To remove the name from the current phonebook, click on the 

 button.



Using the Group Button to Create Phonebooks

1. Pull down the File menu and click on Open Phonebook. The Phonebook dialog box 
appears.

2. At Title (in the Phonebook section), select an existing phonebook from the list. Or 

type the name of the new phonebook and click on the  button.

3. Click on the  button. The Group dialog box appears.

4. Select a phonebook to copy names from. The names in the phonebook appear in the 
Phonebook Contents box.

5. Highlight a name. If you want this name in your new phonebook, click on the
 button. The highlighted name appears in the new phonebook on the right side 

of the screen (titled Group Title). If you do not want this name in your new phonebook, click 
on the 

 button. Eclipse FAX removes the highlighted name from the new phonebook.

6. Repeat Step 5 for all the names in the existing phonebook.

7. Click on the  button or the 
 button. Eclipse FAX asks for the name of your new phonebook.



Importing Phone Numbers into Eclipse FAX

Use this procedure to import text files that contain names and phone numbers. This function
can be very useful if you have a program that exports names and addresses as text files. In 
addition, you can import an existing Winfax phonebook for immediate use in Eclipse FAX.

1. Use the export feature of the application containing the names and addresses to 
create a text file. (See the user guide of the application for details.) If you use a word 
processor to create a text file of names and addresses, be sure to format it as follows:

Line 1      Name (first, middle, last)
Line 2      Company name
Line 3      Fax number
Line 4      Voice number
Line 5 (optional)      Notes

Make sure that each line ends with a carriage return, and that each record is separated with 
a carriage return.

2. Pull down the File menu and click on Open Phonebook. The Phonebook dialog box 
appears.

3. At Title, select an existing phonebook from the list. Or type the name of the new 
phonebook.

4. Click on the  button. If you have a Winfax phonebook that you want to 
import, click on the file type selector and choose Winfax PBK as the file type instead 
of TXT. Select the file to import. Eclipse FAX imports your file.



Advanced Phonebook Features

The Home and Current Area Code fields in the Send Setup dialog are used to activate the 
automatic phone number generation feature. If you are based outside the United States or 
do not wish to use this feature, leave these fields blank and the program will not modify your
phone numbers prior to dialing.

Portable computer users should complete these fields with 3-digit area codes prior to 
entering phone numbers into a phonebook. When set up, the program will automatically 
change the number dialed depending on the area code entered in the Current Area Code. 
For example, if your Home Area Code is 212 and you are currently in 213 (and have entered 
213 into Current Area Code), the program will add 212 to the numbers in your home area 
code prior to dialing them and will dial only the 7 digit local number for 213 area codes. Also,
any numbers that are Added to the phonebook without an area code will be saved with the 
current area code inserted in front of it (so that the correct number will be dialed when you 
return to your home area code).

If you enter a phone number that is 5 digits or less, the program will not put an area code in 
front of the number. This is useful if you have an inter-office phone system that lets you send
faxes to an extension.



Searching for Names in the Phonebook

Eclipse FAX's search feature makes retrieving names from the phonebook even easier. 
Simply type the first letter (or letters) of the person's last name and press Tab. Eclipse FAX 
will retrieve the first record that matches the letters you entered. If the entered letters 
match more than one record, the first match (sorted alphabetically) will appear.



Exporting Information from Phonebooks

1. Pull down the File menu and click on Open Phonebook. The Phonebook dialog box 
appears.

2. Select a phonebook to export from.

3. Click on the Export button. The Create Data File dialog appears.

4. Type a name for the export file. Click on the  button. A text file containing 
all of the information from the selected phonebook will be created.



Sending Faxes from Windows Applications

1. Create your document. Use whatever Windows application is appropriate (Word, 
Excel, etc.).

2. Pull down the File menu and click on Print.

3. Check the printer name shown. If "Eclipse on ..." appears, Eclipse FAX is already your 
default printer. Go to the next step. If "Eclipse on ..." does not appear, click on the 
Printer Setup or Select Printer button. Click on Eclipse on ..." when the Print Setup 
dialog box appears. Then click on the  button.

4. Make any necessary selections. These include the number of pages to be printed 
(faxed), or the number of copies. Then click on the  button. The Send Fax dialog 
box appears.

5. Complete the fields in the dialog box as needed. You can get help by clicking on the 
descriptions below.

Name
Company
Fax
Voice
Phonebook Notes
Local Prefix
L. D. (Long Distance) Prefix
Phonebook
Fax To Phonebook
Cover Sheets
Include Note on Cover
Letterhead
Second Sheets
Send Immediately
Fax Preview
Mark Up
Place Image
Append Pages

6. Click on one of the following buttons to proceed:

To send the fax, click on the  button. If you set up call monitoring, a 
dialog box appears on your screen, displaying the call's progress.

To save the fax in a file, click on the  button.

To add the name and fax/voice numbers to the currently selected phonebook, click on the

 button.

To update the currently selected entry, click on the  button.



To remove the currently selected entry from your phonebook, click on the  
button.

To clear the fields in the Fax To section of the dialog box without deleting any information 

from the phonebook, click on the  button.

To send the fax to several people at once, click on the  button. You can also 
choose to save this grouping permanently in a phonebook once you have called up the 
Group dialog.



Sending Faxes from Eclipse FAX

1. Double-click on the Eclipse FAX icon if necessary to make the E-FAX window appear 
on your display.

2. Tell Eclipse FAX which fax you want to send or re-send. You can use any of the 
following options to display a list of stored or received faxes:

Open File, on the File menu
Open Indexed, on the File menu
Send Log, on the Send menu
Receive Log, on the Receive menu

3. Click on the fax you want to send. Eclipse FAX displays it on your screen.

4. Pull down the Send menu and click on Send Fax. Or click on the Send Fax icon on the 
toolbar (fourth from the left). The Send Fax dialog box appears.

5. Enter the necessary information.

6. Click on the  button to send your fax. If you set up call monitoring in the
Setup dialog box, a dialog box displaying the call progress appears on your screen. 
After completing (or attempting) fax transmission, Eclipse FAX stores various 
information in the send log for future use.



Sending Faxes Manually with Eclipse FAX

Manual Send is useful when you must dial an access code or password, such as a calling 
card number, in order to connect to the remote fax.

When using your calling card or access number with manual send, be aware that the number
is saved in your system's e-fax.ini file for future use. Each time you use manual send, your 
access code is readily available. However, this could pose a security risk for those who may 
share their computer with other people.

Also, as noted in the section on CAS, Manual Send and Manual Receive are not available with
CAS boards. Review the README section on CAS for more details.

You will need to listen to the dialing process, so be sure to turn your speaker on (in the Send 
Setup dialog) before you start. Follow this procedure:

1. Create your document and Fax to File, then load it in Eclipse FAX; or load an existing 
document in Eclipse FAX.

2. Choose Manual Send from the Send menu. A Send Fax dialog will appear, allowing 
you to choose a phonebook entry and a cover sheet. Note that you cannot choose 
letterhead or other options; Manual Send assumes that your document is ready to go 
and doesn't need any additional work, since you are sending from within Eclipse FAX. 

When you have made your choices, click on .

3. Next, you will see a dialog requesting your phone company access number, your 
account code, and any other number you may need. The recipient's name and voice number
will appear at the top of the dialog as a reference; the fax number will be filled in for you.

4. When you have made your entries, click the button to the right of the access number 
field. The fax modem will dial the access number for you. Listen for your long-distance 
company's signal to proceed, then...

5. Either click on the Dial Fax button to dial the fax number, or click on the Dial Account 
button to dial your account code, depending on which one your phone company 
requires first. When you hear the signal to proceed, click the other (Fax or Account) 
button.

6. If you need to use the Other field for any additional numbers to dial, click on the Dial 
button when prompted by your phone company.

7. When you have reached the other fax machine, it will answer the line and send a 
tone to your computer. This is your signal to click the Connect button. Your fax 
modem will send a tone in response, and the fax will be sent.

NOTE:
If you have a CAS fax board, such as the Intel SatisFAXtion, this option will not appear. 
Eclipse FAX can't send faxes manually with a CAS board because the program doesn't have 
direct control of the hardware.



Collecting Pages

Use this procedure to merge many different fax documents into one file for storage or 
transmittal. Make sure that the documents you want collected are on disk, either as received
faxes or saved files.

1. Pull down the File menu and click on Open File. Choose a file in which to collect other 
fax files.

2. Pull down the File menu and click on Collect Pages. The Collect dialog box appears.

3. Use one of the  buttons to select the first file you want added to the one
already on your screen. To remove a document file from the collection, highlight it 
and click on the 

 button.

4. Click on the  button or the View button to see the collected pages. As 
noted above, you can modify your collection using the toolbar. To return to the Collect dialog
box, click on the Collect icon again. You can use this dialog box to add documents to the 
group at any time.

When using the Collect Pages dialog, the Delete button removes the file from the collection 
only. It will not be removed from your disk.



Monitoring Transmissions

The Eclipse FAX Setup dialog box includes a setting for displaying ongoing transmission 
information while sending or receiving faxes.

1. Start the Eclipse FAX Manager.

2. Pull down the Send menu and choose Setup. The Setup dialog box appears.

3. Click in the box next to Show Call Progress.

Eclipse FAX will display a Transmission Status dialog box while it sends faxes. This dialog box

provides ongoing transmission information. It also includes a  button. Clicking 
on this button stops the transmission.



Stopping Transmission

How you cancel a fax depends on whether or not you set Eclipse FAX up to display fax 
transmission status. Use these procedures to stop sending or receiving faxes during 
transmission. If you set Eclipse FAX up so that it displays transmission status on your screen,

click on the  button.

If your call progress is not automatically displayed:

1. Load Eclipse FAX if necessary.

2. To cancel an outgoing fax, pull down the Send menu and click on Show Status. To 
cancel an incoming fax, pull down the Receive menu and click on Show Status.

Eclipse FAX stores the canceled fax in either the Send or Receive Log, with an "Error" status. 
There may be a delay of a few seconds before the fax actually stops.



Retrying Faxes

Fax transmissions can fail for many reasons, including paper jams on a remote machine and 
busy signals. If your transmission fails, Eclipse FAX hangs up and tries again later. Your 
entries on the Setup dialog box determine how long the system waits between tries and how
often it makes the attempt. If Eclipse FAX retries the maximum number of times without 
connecting, you can send the fax again.

1. Pull down the Send menu and click on Log.

2. Highlight the appropriate fax and click on Re-send.



Scheduling Faxes

With Eclipse FAX you can schedule fax transmissions to take advantage of nighttime phone 
rates or for the convenience of the recipient.

1. Load the fax file that you want to schedule.

2. Pull down the Send menu and click on Send Fax. Or click on the Send Fax icon on the 
toolbar. The Print dialog box appears.

3. Click on the  button. The Send Fax dialog box appears.

4. In the Schedule section click on Hours, Minutes, or Date, and use the up and down 
arrows to select the desired time and/or date. The Eclipse FAX Manager must remain running
(either as a window or an icon) until it transmits all faxes scheduled.



Rescheduling and Unscheduling Faxes

Use this procedure to reschedule faxes. Also use it to remove faxes from the list of those 
scheduled to go out later.

1. Pull down the Send menu and click on Log. A list of faxes appears.

2. Click on Unsent Faxes, if necessary to display the faxes not yet transmitted.

3. Select the fax you want to reschedule or delete. To delete the fax, click on the  
button. To change the date or time scheduled, click on the 

 button.

4. Change the time and date as needed. Then click on the  button. Eclipse FAX 
reschedules your fax.



Sending a Quick Note

Quick Note will allow you to send a cover sheet with a note attached. The current document 
will not be sent.

1. Choose Quick Note from the Send Menu (note that Fax Cover and Include Note are 
already checked).

2. Choose a recipient from the phonebook, choose a coversheet and click Send Fax.

3. When the Notes dialog appears, enter your text.

4. Click Send, and the note will be faxed.



Receiving and Viewing a Fax

Receiving a FAX in Windows is automatic if Eclipse FAX is running. Just be sure that the 
settings in the Receive Setup dialog are acceptable. Follow this procedure if you are unsure 
whether or not you are ready to receive:

1. In Windows, start Eclipse FAX, if it is not already running.

2. Pull down the Receive menu and click on Setup. The Receive Setup dialog box 
appears.

3. Make sure an "X" appears in the box in front of each of the following options:

Notify on Reception
Show Fax Status
Automatic Reception

4. Click on the  button.

5. Have someone send you a fax of several pages.

6. Watch the Reception Status dialog box as your computer receives the fax. When the 
transmission ends, Eclipse FAX alerts you with a message. If the transmission was 
interrupted for some reason, Eclipse FAX will attempt to save as many pages as possible. 
Check with the sender if you think that you may have gotten an incomplete transmission.

7. Click on the  button

8. Click on the Eclipse FAX icon, if it is not already displayed.

9. Pull down the Receive menu and click on Log. Information about the newly received 
fax appears in the Log dialog box.

10. Select the fax you just received. Then click on the  button. Eclipse FAX 
displays the top half of the first page of the fax.



Zooming In on a Page

To magnify or zoom in on a page, first be sure you are in Best Fit or Full Page view (zooming 
is not active in Thumbnail view). Then, hold down the left mouse button and select the area 
you wish to magnify. When you release the mouse button, the area you selected will be 
magnified. To return to the previous view, click on the Reset icon, choose Reset from the 
View menu, or press the spacebar. If you are zooming in on an image in the Place Image 
window, only the spacebar method of resetting the view will be available to you.



Receiving Faxes Manually in Windows

Sometimes you may have only one phone line available for both fax and voice 
communication. When that happens, you can use Eclipse FAX to receive your faxes 
manually.

1. Pull down the Receive menu and click on Manual Receive. When your fax hardware 
connects with the sender, Eclipse FAX takes over and receives the incoming message.



Viewing Faxes

Eclipse FAX provides several ways to display faxes that you want to view. You can:

Pull down the Receive menu and click on Log. When the dialog box appears, select the 
fax and click on the  button.

OR

Pull down the Send menu and click on Log. When the dialog box appears, select the fax 
and click on the  button.

OR

Pull down the File menu and click on either Open File or Open Indexed. Once displayed, 
you can use the buttons on the View Toolbar and the Thumbnail Toolbar to get different 
perspectives on your fax.



Rotate Pages

If you receive a fax that was fed into the sending fax machine upside down, that fax will also
appear upside down on your display. To avoid having to click on the rotate button every time
you display the fax, choose Rotate Pages from the Special menu. This function will rotate the
fax and save it in the rotated position.

1. Choose Rotate Pages from the Special menu.

2. If the fax has only one page, or only the current page is upside down, click Current 
Page. If more than two consecutive pages are upside down, click on Page Range. If 
the entire document is upside down, or several non-contiguous pages need to be 
rotated, click on All Pages.

3. Click on the Add button. The page(s) will be added to the Rotate list on the right. Use 
the Remove button to remove pages from the list. When you have added the proper 
pages, click on OK.

4. At the Save File dialog box, choose a new name for the fax, or click on OK to keep the
old one. Eclipse FAX will process the pages that require rotation and save them, along
with any other pages, to the chosen file name.



Saving Faxes

Use this procedure to save faxes in files so that you can reuse them later. For example, if 
you frequently fax the same bulletin or spread sheet, you need only store it once. You can 
resend it any number of times.

1. Create or open the document you wish to save as a fax file using the Windows 
application of your choice. (MS Word, Excel, etc.)

2. Select Eclipse FAX as your printer and choose Print. The Print dialog box appears.

3. Click on the  button. The Send Fax dialog box appears.

4. Click on . A File dialog box appears.

5. Type a file name and choose a file type. You can choose from among the following 
formats:

Group 3 TIF
Group 4 TIF
Uncompressed TIF



Storing Faxes in an Index

After you view a fax, Eclipse FAX asks if you want to store the fax using an index. You can 
also save a fax file with an index at any time using the Save With Index option on the File 
menu.

1. With a fax displaying on your screen, pull down the File menu and click on Save With 
Index. The Save with Index dialog box appears.

2. At Index, enter an index name. To save the fax in a new index, type the index name. 
You can enter up to 50 characters. To save the fax in an existing index, click on the down 
arrow to display a list of indices from which you can choose.

3. Choose 'Compress to Group 4 Tiff' if you wish to compress the file to Group 4 Tiff (in 
order to conserve disk space).

4. At Note, type a note describing the fax file in more detail.

5. To see more about the fax file, click on the  button.

6. Click on the  button to save the file in the index and with the details specified.



Retrieving Indexed Faxes

Use this procedure to retrieve a fax previously saved with an index. Eclipse FAX provides a 
variety of filters and sorting options that make the process easy and quick. Once you find 
the fax, you can display, modify, or print it. You can also send it out again.

1. Pull down the File menu and click on Open Indexed. The Open Indexed dialog box 
appears.

2. Search for the fax you want using the following fields.

Index
Search Index
View All
(fax list)

3. Sort the indexed faxes in the fax list using the following fields.

Alphabetical
Date/Time
Ascending
Descending

4. Highlight a fax in the list. Then use these additional tools to find out if it is the specific
fax

Note
Details

5. Once you find the specific fax needed, choose one of the following:

View
Delete Item

Currently, there is no way to directly remove an entry from the index. Using the Delete Entry
button will delete both the index entry and the fax file. Therefore, if you wish to remove an 
index entry but keep the fax, you must first view the fax and choose Save As form the file 
menu to save a copy of the fax with a different name. Then choose Delete Entry from the 
Open Indexed dialog, and the original fax will be deleted along with the index entry.



Setting Up the Printer

Before printing, you must make sure that you have the correct printer selected.

1. Pull down the File menu and click on Printer Setup.

2. Select the printer you want to use for your Eclipse FAX output. If you do not see your 
printer listed, consult the printer installation instructions in the Microsoft Windows 
User's Guide.



Printing One or More Pages

Use this procedure to print one or more pages of your fax.

1. Open the fax file and view it.

2. Pull down the File menu and click on Print. The Print dialog box appears.

3. Enter the number of copies and which pages to print. Eclipse FAX sends the fax to 
your printer.



Printing Part of a Page

Use this procedure to print part of a page from your fax. (Why print the entire fax when you 
need only a paragraph?)

1. Open the fax file and view it.

2. Pull down the File menu and select Print Area. The pointer becomes a cutting knife.

3. Click and drag a box around the area of the fax page that you want printed. The Print 
dialog box appears.

4. Type the number of copies you want, then click the  button.



Printing Thumbnail Pages

Use this procedure to print more than one fax page on a single piece of paper.

1. Open the fax file and view it.

2. Pull down the File menu and click on Print Thumbnail. The Print Thumbnail dialog box 
appears.

3. Enter the number of copies you want. Then enter the number of fax pages to print on
each sheet. Click on the  button. Eclipse FAX prints your fax.



Printing from Other Windows Applications

Use this procedure, and the Clipboard, to print from other Windows applications.

In Eclipse FAX:

1. Open the fax file and view it.

2. Pull down the Special menu and click on either Select or Select All.

3. Use the pointer to mark the section of the fax page you want copied.

In the other application:

4. Switch to the other application.

5. Move the cursor to where you want the fax section copied.

6. Use the Paste option to transfer the contents of the Clipboard into this application.

7. Print the fax using the instructions in that application's manual.



Scanning Documents

Use this procedure when you want to scan the text or graphic from a piece of paper.

1. Place the document in the scanner.

2. To scan and fax a document immediately, pull down the Scan menu and click on Scan
to Fax. To scan so that the item appears on your monitor, click on Scan to View. To 
scan so that the item goes directly to the printer, click on Scan to Printer.

3. Click on the  button. After scanning the first page, Eclipse FAX gives you a chance
to scan another page. After scanning all the pages, click on the 

 button.

What you see when you finish scanning depends on the option you selected. If you chose 
Scan to Fax, the Send Fax dialog box appears. If you chose Scan to View, the scanned image 
appears on your monitor. If you chose Scan to Printer, your printer produces the scanned 
image.



Setting the OCR Options

Before using OCR for the first time, follow these steps to check the OCR settings.

1. Open the document you want to OCR, from either of the Logs or the File menu.

2. Pull down the OCR menu and choose OCR Setup. The OCR Setup dialog will appear. 
The various fields and settings are explained below.

Mode
Language

Unrecognized Character
Automatic Column Recognition
Retain Format

Edit Window
File
Clipboard

Launch
Browse



Using OCR

Using the OCR capabilities in Eclipse FAX consists mainly of defining the area of your 
document to be recognized; Eclipse FAX will then scan the selected area (or page, file or 
zone) and either store the results in a file or display them in a window. During the 
process, Eclipse FAX will scroll the fax window so you can see both the source image and 
the text produced. What happens to the text after the OCR process is complete depends 
on the options chosen in the OCR Setup dialog box.

OCR File
This command will OCR multiple page documents. A dialog will appear asking for the 
range of pages you want recognized. Enter a range, or click OK to accept the default 
of All. During the OCR process, the display will indicate which page is currently being 
recognized and what percentage of the page has been completed.

OCR Page
This command will OCR the currently displayed page. The program will display the 
percentage complete as it processes.

OCR Area
This command allows you to OCR a small section of your fax quickly. When chosen, 
your normal arrow cursor changes to a crosshairs cursor. Select the desired section of
your fax. The selected text will be recognized.



Zones and OCR

A zone is a single element of an image consisting of text or graphics surrounded by 
white space. For example, a page from a magazine might contain several columns, a 
headline, and a photograph. Each column would be a zone. The photograph is 
another zone, and the headline another. Your OCR sessions will tend to be more 
successful if you define these areas before the process begins. That way, the 
program will not have to define and ignore white space, graphics, random markings, 
and handwritten text. The program will also keep the recognized elements of the 
page separate.

Select Zones
Use this to draw a box around each element on the page that you want recognized. 
Omit drawings, photographs and handwritten text.

Clear Zones
This command de-selects the zones you have chosen, allowing you to start over.

OCR Zones
Begins the OCR process on the selected zones. The program will follow the numbered
order of the zones as displayed.



A Word About OCR Accuracy

Have faxes sent in Fine mode whenever possible.

Avoid highly stylized fonts. Plain Times, Helvetica, and Courier work best.

Try not to OCR faxed photocopies - use originals when possible.

Smaller fonts will not be recognized as readily as larger ones

You can't OCR in the background, so don't use OCR on Reception if you plan on 
running Eclipse FAX minimized and/or unattended.

The program can compensate for a small amount of skewing; however, the straighter 
the page is going in to the remote fax machine, the better the results when 
recognizing.

In this version of Eclipse FAX, it is not possible to OCR a fax that is rotated 90° or 
270°. For faxes rotated 180°, you can use the Rotate Pages function (under the 
Special menu).



Creating Cover Sheets

With Eclipse FAX you can use your own custom page elements (a logo, signature, etc.) on 
the fax cover sheets provided with the program. These fax cover sheets have space open for
your company logo or other page elements you may want to include.

1. If you have the image in a file, pull down the File menu and click on Open File. If you 
do not have the image already in a file, fax a copy of the logo or other element to 
Eclipse FAX. By doing this, you can display and modify the logo with Eclipse FAX. If 
you have a scanner and do not have the image already in a file, use your scanner to 
display the image on your monitor.

2. Pull down the File menu and click on Open. The File dialog box appears.

3. Switch to the Eclipse FAX directory. At File Type, select Cover Sheet. The files 
containing Eclipse FAX's five pre-formatted cover sheets appear in the display.

4. Select the cover sheet you want and click on the  button. Eclipse FAX opens the 
file.

5. Pull down the Special menu and click on Place Image. A new window opens.

6. In the newly opened window, pull down the File menu and click on Open. The File 
dialog box opens.

7. Open the fax file with the logo in it.

8. Resize the window to the size you want. Then pull down the Edit menu and click on 
either Select or Select All.

9. Click and drag to select the area you want to appear on the cover sheet.

10. Pull down the Special menu and click on Paste. The window with the logo in it 
disappears and the area you selected appears on the current fax page with a box 
around it.

11. Position the pointer on the box with the new page element in it. Hold down the right 
button on your mouse, and drag the element to where you want it.

12. Click the pointer on the fax page anywhere outside the box. This tells Eclipse FAX that
you want the new page element merged with the fax page on the screen. The Save 
As dialog appears. After Eclipse FAX merges the element with the page you cannot 
move it again.

13. Name the file and click on the  button. The next time you use this cover sheet to 
send a fax, your new page element will be included on it. Note that if you give the 
cover sheet a new name, the Sender and Recipient information will not be pasted on 
the cover sheet (E-FAX considers it a 'Custom' cover unless it uses on of the original 
names). To avoid this, do not rename the cover sheet when saving it.



Creating Letterhead and Second Sheets

Letterhead and Second Sheets are used like electronic stationery; that is, Eclipse FAX takes 
the image of your document and 'prints' it on top of the letterhead. First, you'll need to get 
the letterhead on your screen in one of the following ways:

1. Simply fax yourself a copy of your existing letterhead and second sheets. This works 
well if you have simple graphics, and use black or very dark colors. Complex logos or 
bright colors will not fax as well.

2. Using New Page, get a blank page on the screen. Then, type any text that would 
normally appear on your letterhead (address, phone, etc.) in the proper location 
using the Text tools. Use Place Image to paste in your company logo (follow the 
instructions for using your scanner with Eclipse FAX, or just fax it to yourself).

3. Use your scanner to scan in your letterhead. This is a better choice if you have an 
elaborate logo or design.

Once the image is on your screen, choose Save As from the file menu. Under file type, click 
on Letterhead or Second Sheet. Switch to the \EFAX\IMAGES directory and name your 
letterhead. The next time you send a fax, this name will appear as a choice when the 
Letterhead check box is selected in the Send Fax dialog.

TIP:
When using letterhead and second sheets for the first time, use the Preview check box to
be sure you've set your margins properly. If you have not taken the logos or text on the 
letterhead into account, your document may overlay them.



Custom Images

This feature allows you to build a library of commonly used images (such as signatures or 
logo images). These can be retrieved and pasted using a single menu item, instead of using 
the entire Place Image process. Use the following procedure:

1. Select Place Image from the Special menu, locate and open your image file, and 
zoom it to the proper size. Refer to the procedure on placing a signature for detailed 
instructions.

2. Choose Select from the Edit menu in the Place Image window. Highlight the desired 
area of the image.

3. Choose Save as Custom Image from the File menu in the Place Image window. The 
Custom Images dialog box appears.

4. Enter a name for this image in the Image Names field. Click on Add Name to add this 
image to the image library. If you already have images in your image library and wish
to replace one image with another, click on Replace.

5. You can choose a Hot Key for the image by clicking the down arrow next to Image Hot
Key. This will give you a list of available letters based on the name you assigned to 
the image. Choose one by clicking on it.

6. To place this image, simply choose it from the Special menu (or use your assigned 
Hot Key combination, if any). The image will be pasted as if you had opened it in the 
Place Image window and selected it.

7. Choosing Custom Images... from the Special menu allows you to rename or delete 
images from your image library. Click on the desired image, then click Delete to 
remove the image from the list, or type a new name and click Update Name to 
rename it.



Placing a Signature on a Fax

This procedure can be used when you want to place an image of any kind on a fax before 
sending.

1. If you do not already have the image in a file, fax a copy of your signature to Eclipse 
FAX. If you have a scanner and do not have the image already in a file, use your 
scanner to scan your signature to a file.

2. Create your document in the application of your choice. When you are ready, choose 
Print (usually under the File menu). At the Send Fax dialog, click on the Place Image 
check box, and any other options you wish to use (cover sheets, letterhead, etc.).

3. When the Eclipse FAX program appears with your document, the Place Image window
will be open. Choose Open from the window's File menu, locate your signature file 
and click on .

4. Resize the window to the size you want, then pull down the Edit menu and click on 
either Select or Select All.

5. Click and drag around your signature.

6. Pull down the Special menu and click on Paste. The Place Image window disappears 
and the area you selected appears on the current fax page with a box around it.

7. Position the pointer on the box with the new page element in it. Hold down the right 
button on your mouse, and drag the element to where you want it. Use the Page 
Selector buttons on the toolbar if you need to change pages.

8. Click on the  icon, and Eclipse FAX will ask if you want to merge the image. Click 
on 

. You will be prompted for a file name; rename the document or use the file name 
provided. The fax will be merged and sent to the recipient chosen in the Send Fax dialog.



Faxing with DDE

To get you started, the BULKMAIL.DOC file includes two macros for use in MS-Word for 
Windows, Version 2.0. The first macro, BulkMail, searches for embedded fax numbers in a 
mail merge document and uses them to send a group of    faxes. The second, SendFax, takes 
a highlighted name and sends a fax to that person after looking up his fax number in the 
phonebook.

Before you can use these Word macros, you must have done the following: 

installed E-FAX
installed the MS-Word macros
entered the relevant phone numbers in the E-FAX phonebook (SendFax macro only)
selected the correct E-FAX phonebook (SendFax macro only)

Note:
For information about how to use mail merge in MS-Word, or for information on how to install
and use a macro in Word, follow the instructions in the Microsoft Word User's Guide. 

1. Install the BulkMail macro in Microsoft Word.

2. In your Word document, merge your form letter and database to a new document. 

Be sure to follow the instructions in the BULKMAIL.DOC file so that the form letter has the 
necessary fields for faxing. 

3. Run the BulkMail macro. 

The macro selects E-FAX as the printer, dials the fax number, and transmits the fax. It then 
processes the next document in the merged file.
After sending all of the documents as faxes, the macro resets your system to the previous 
printer. 
A simpler way of using DDE is illustrated in the macro SendFax. This macro takes a name 
highlighted in your Word document and looks it up in the current phonebook. It will 
remember and use any cover sheet, letterhead or second sheet used in the previous 
transmittal. It then processes the document and faxes it.

1. Install the SendFax macro in Microsoft Word.

2. Highlight the name of the recipient in your Word document. Be sure this person is 
entered in the current phonebook, and that the highlighted name matches the 
phonebook entry exactly. Highlight just the name; don't highlight any spaces, 
punctuation or carriage returns at the end of the name. 

3. Run the SendFax macro. The document will be processed and faxed.



Using Eclipse FAX with PackRat
This information pertains to users of Polaris Software's PackRat information manager. Eclipse
FAX is integrated with PackRat in three ways:

It can use PackRat's rolodex as a phonebook
It can log faxes into PackRat as disk items
It can search for faxes logged in PackRat.



PackRat Phonebook Integration

When you want to use PackRat as your phonebook, follow these steps:

1. Locate and open the document you want to fax, either within Eclipse FAX or another 
application. Choose Print (or Send Fax within Eclipse FAX).

2. At the Send Fax dialog, click on the down arrow next to Phonebook. You will see 
PackRat as one of the choices. Click on it to select it.

3. Click in the Name field, so that you have a blinking cursor. If you know the name of 
the recipient, type in the first few letters of the last name and press Tab. If there is 
only one name in PackRat that matches what you typed, that name will appear. 
Otherwise, just press the Tab key.

4. The PackRat Integration Library screen appears. Exactly what you see depends on 
whether you typed a few letters of the last name or not. If you did, you will see a 
screen showing all of the matches PackRat found, so go on to the next step. If not, 
you will see a search criteria screen. Enter any search parameters and click OK.

5. Choose the name of the person you want to fax to. If you like, you can choose more 
than one name either by dragging over a range of names, or by shift-clicking or 
control clicking. When the name(s) are selected, click OK.

6. You will return to the Send Fax dialog. The name will appear, ready to send. If you 
chose more than one name, the words Group Send will appear. Everyone in the 
selected group of names will get a copy of the fax (provided they have a valid Fax 
number entered in PackRat!).



Logging Faxes in PackRat

Use the following procedure to log the displayed fax in PackRat as a disk item:

1. If it is not already displayed, open your fax using any of the usual methods (Send or 
Receive Logs, File menu, etc.).

2. Pull down the File menu and choose Log in PackRat. The Add Document screen will 
appear.

3. Enter any necessary information (keys, summary, etc.) and click OK. The first two 
keys will already be filled in for you. For more detailed information on the Add 
Document screen, refer to your PackRat documentation.



Searching for Faxes in PackRat

To search for a previously logged fax in PackRat, use this procedure:

1. In Eclipse FAX, pull down the File menu and choose Find Fax in PackRat. The Search 
Disk File Facility screen appears.

2. Enter the search criteria in the appropriate fields and click OK. For more detailed 
information on the Search Disk File Facility screen, refer to your PackRat 
documentation.

3. If more than one file fits the search criteria, choose the desired one from the Select 
File(s) screen and click OK. The fax will be displayed.



Glossary
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Message from the Chairman

We've all heard of the paperless office. Personal computers were supposed to help cut 
down on paper. Instead, paper use - and paper shuffling - have increased at an 
unprecedented rate.

So now, we look at paper spilling out of wastebaskets, recycling boxes, and file cabinets; 
and we see hours spent routing, photocopying, and filing that paper. We also see clear-cut 
mountains, wildlife without shelter, and rain carrying topsoil and chemicals into streams. 
Each piece of paper represents a drain on our productivity and a stress on our environment.

The Eclipse Systems' mission is to develop paper-free solutions for a more productive 
office and a more livable earth. Like all Eclipse software, Eclipse FAX is designed to help 
make your work paper-free.

In harmony with its mission, Eclipse uses recycled material for its products whenever 
possible. Notice the soft color of the pages in the manual; we printed it on 100% recycled 
paper. The softer color is easier on your eyes. The recycled paper is easier on the 
environment.

Eclipse Systems is committed to the paperless office. We've made it our mission to make it
a reality. To improve your working environment and to do some good for the earth, we ask 
that - when practical - you make it your mission to display documents on your computer 
screen instead of printing them. What we do as individuals may not seem to have much 
impact, but our cumulative efforts will make this a better world.

Victor H. Schiller

.
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Stands for Tagged Image File Format; it is a way of storing a picture on disk.



If you choose to save a multiple page document as a .PCX file, it will be saved as a series of 
individual files with file names assigned by page number. This is because the .PCX file format
supports only single page files. The .DCX format was created to overcome this limitation; it 
is essentially a .PCX file that supports multiple pages.



DDE (Dynamic Data Exchange)
A channel through which Windows applications pass information to each other. For example, 
when you link a table in a Word document to data in Microsoft Excel, Word uses DDE to 
update the document when the data in Microsoft Excel changes.



The process of making a large amount of data fit into a smaller amount of disk space than 
would otherwise be necessary.



To place differently colored pixels next to each other to produce the illusion of a new color.



A sequence of actions that is named and stored. In programs that use them, macros can be 
assigned to keys or menus.



A tool in Eclipse FAX that displays higher-resolution FAX data on the lower-resolution screen.



The Toolbar in Eclipse FAX is displayed across the top of the screen whenever a FAX is 
displayed. The icons represent different 'tools' or functions in the program.



A 'COM' (or COMmunication) Port is the device through which most fax modems interface 
with your computer. Sometimes referred to as 'serial' ports.



A Scanner is a device that can copy or 'scan' an image on a piece of paper and convert that 
data into a disk file.



The process of reading in an image from a scanning device.



A program whose function is to communicate directly with a particular piece of hardware. 
Your printer, for example, needs a 'driver' to act as a go-between for Windows.



A list of all faxes, either sent or received. These are grouped into either Pending/Sent or 
Read/Unread.



A greatly reduced representation of a page. Useful when many pages need to be viewed at 
once.



Stationery bearing your company logo or a personal design.



A series of digits that obtains an outside line, as in a PBX system.



Key word or phrase that describe the contents of a file; used by the program for quick 
retrieval.



A collection of names from your phonebook(s).



A function in Eclipse FAX that displays your fax a half page at a time for quick viewing.



An Eclipse FAX function that gathers separate files together into a single file.



The process of dragging one page on top of another, in thumbnail view, for the purpose of 
merging the two pages together.



Shows your document at its 'actual' size.



CAS stands for Communicating Applications Specification; it is a software standard that 
allows E-FAX to communicate with control software on certain types of fax hardware.



A page listing the sender and recipient of a fax; can be pre-formatted or user-defined.



Shows two pages on the screen at once.



TSR stands for Terminate, Stay Resident; refers to a program that loads but does not execute
immediately.



A line across the top of a fax that identifies the sender.



Shows one complete page of a document on the screen.



If your stationery has a different layout for the second page, you can scan it as a second 
sheet and use it in Eclipse FAX.



Identifies your computer fax to recipients.



A feature in Eclipse FAX that allows you to place a commonly used image (like a signature or 
a logo) by selecting it from the Special menu.



Links files of a certain type to the application that created them, allowing you to start the 
application by simply clicking on the document you want to use.



A portion of a fax that has been marked as containing only text.



A feature in Eclipse FAX that allows you to send a just a cover sheet with a note on it.



Stands for Optical Character Recognition; it is the process of converting images to text.





Name

Type in the name of the person or company to which you plan to send the fax. Enter the 
name as you want it to appear (first name, middle initial or name, last name). To use a name
in your phonebook, click on the down arrow to the right of the field. Then click on the name 
you want to use. Eclipse FAX automatically alphabetizes names, using the last name and 
then the first name. It recognizes and ignores most suffixes (such as "Jr.").



Company

Type the name of the company where the recipient works, or leave the field blank. To use a 
company already in your phonebook, click on the down arrow to the right of the field. Then 
click on the company you want to use. To change the company, either use the down arrow or
click on the  button and type a new company name. You can have more than one 
person's name associated with a company name. To search the names in the selected 
phonebook by company, first enter the company name in the Company field. Then click on 
the arrow to the right of Name. The names that appear include only those working for the 
company you specified.



Fax

Type the fax number of the intended recipient just as you would dial it. Only include the area
code if faxing to someone outside your area code. The actual number dialed by the fax 
system is formed by appending this number to the Prefix. If you select a name from a 
phonebook, Eclipse FAX completes this field for you. When you and your computer travel, be
sure to adjust the Current Area Code field on the Send Setup dialog box. By making this 
small adjustment, you can avoid entering area codes for all the phone numbers in your usual
location.



Voice

Type the recipient's regular (voice) phone number. This is only for your reference; Eclipse 
FAX does not use it.



Phonebook Note

Type a short reference note pertaining to the recipient. Eclipse FAX does not print this note 
on the cover sheet. (If a note already appears here, you may have entered it in the 
phonebook.)



Phonebook

Click on the down arrow to select a phonebook.



Fax To Phonebook

Click here to send the fax to everyone in the currently selected phonebook.



Cover Sheets

Click on the down arrow to select a cover page. Information from the Eclipse FAX Setup 
dialog box (such as your name, station ID, and fax number) automatically prints on your 
cover page when you send a fax.



Include Note

If you want to include a short note on the cover sheet (for inter-office routing, callback 
instructions, etc.), check this box. Your text will wrap as it would in a normal word processor. 
When you click the  button, another dialog will appear for you to enter your note.

If you are sending a Group fax, you can enter separate notes for each recipient by choosing 
a name from the menu at the top of the note dialog. Click on the  button after each note,
or you will lose the note for that recipient. The Duplicate buttons will insert the note text 
from previously ADDed notes.



Letterhead

If you have any letterhead saved in the IMAGES directory, you can click on this check box to 
choose one.



Second Sheets

If you have any second sheets saved in the IMAGES directory, you can click on this check 
box to choose one.



Send Immediately

The Send Immediately check box will cause that fax to preempt any pending faxes in the 
queue. Otherwise, click on Hours, Minutes, or Date, and use the up and down arrows to 
select the desired time and/or date.

Send Immediately has no effect if you have no pending faxes; a fax sent to an empty queue 
will always be sent immediately.



Fax Preview

Click here if you want to use Eclipse FAX's viewing options to look at your fax before sending 
it out. The fax appears on your monitor with the View Toolbar visible.



Mark Up

Click here if you want to use Eclipse FAX's editing features to mark-up a fax before sending it
out. The fax appears on your monitor with the Edit Toolbar visible.



Place Image

Click here if you want to place an image on the fax before sending it out. The fax appears on
your monitor with the View Toolbar visible.



Append Pages

Click here if you want to add other fax documents to the end of this one before sending it 
out. The fax appears on your monitor with the Thumbnail Toolbar visible.



Notify on Reception

Click here if you want Eclipse FAX to tell you when it receives a fax. A message appears to 
alert you that a fax has arrived.



Print on Reception

Click here to print faxes to your default printer as soon as Eclipse FAX receives them.



OCR on Reception

Check this box if you want your faxes OCR'd automatically upon reception. If you have 
chosen to save the OCR text to a file, you will be prompted for a file name.



Show Fax Status

Click here if you want Eclipse FAX to display a chart on which you can monitor the progress 
of fax transmission.



Automatic Reception

Click here if you want Eclipse FAX to handle incoming faxes automatically. If you do not 
select this option, you must use the Manual Receive option on the Receive menu to receive a
fax.



Rings Until Answer

Enter the number of times that Eclipse FAX should let the telephone ring before allowing the 
fax or modem to respond. You must have selected Automatic Reception to use this option. 
Typically, this value is set to "1". If you have only one telephone number for both voice and 
fax calls, you may want to enter a higher number.



Forward on Reception

Click on this check box if you want Eclipse FAX to forward received faxes to another location.
Set the number of minutes to wait before sending, then enter a name and phone number for
Eclipse FAX to dial. You can choose a name from the phonebook by clicking on the 
'Phonebook' button.



Group 3 TIF

Compresses the fax image as it stores it on disk. This saves disk space, but takes longer to 
save than Uncompressed TIF. (default)



Group 4 TIF

Compresses the fax image more than Group 3, thereby using even less disk space, but takes
longer to save than Group 3.



Uncompressed TIF

Saves the file without compressing it. This is the fastest of the three choices, but it uses the 
most disk space.



Index

Click on the down arrow to display an alphabetical list of indexes. If you want to search a 
particular index for your fax, click on that index.



Search Index

Click here to search only the index you selected. The results of the search appear in the log 
below.



View All

Click here to search all the indexed faxes. The results of the search appear in the fax listing 
area below.



(fax list)

The result of Eclipse FAX's search appear here. Depending on the type of search you 
selected, the list includes either all your indexed faxes or just those in a selected index.



Alphabetical

Click here to sort the fax list alphabetically by sender/destination.



Date/Time

Click here to sort the faxes in the fax list by the date and time sent or received.



Ascending

Click here to sort the fax list in ascending order. If you selected an alphabetical sort, A's 
appear first, B's next, etc. If you selected a date and time sort, the earliest fax appears first.



Descending

Click here to sort the fax list in descending order. If you selected an alphabetical sort, Z's 
appear first, Y's next, etc. If you selected a date and time sort, the most recent fax appears 
first.



Note

Shows the text entered when you originally saved the highlighted fax.



Details

Click on the  button to see more information about the file, including the DOS file 
name.



View

Select a fax in the list. Then click on the  button to display and work with that fax 
file.



Delete

When you select a fax and click on the  button (in either log), you will be presented with 
a dialog box asking if you wish to delete the file only, or both the file and the log entry. This 
change was made to allow you to keep a record of a fax without having to keep the file itself.



New Page Paper Size

Click on the down arrow to the right of the field to choose the size of the paper that Eclipse 
FAX should assume for display and print purposes.



Send Resolution

Choose Best Resolution if the receiving machine supports high resolution; otherwise, choose 
Standard.



Detect Dial Tone

Tells Eclipse FAX to wait for a dial tone before dialing a phone number.



Tone/Pulse

Click on Tone if your phone has touch tone capability. Or click on Pulse if it does not.



Show Fax Status

Click here if you want Eclipse FAX to display the progress of your fax transmissions.



Wait for Connect

Tells Eclipse FAX how long to wait for a connect signal from the receiving fax machine. The 
maximum time allowed is 60 seconds. When placing international calls, you may want to set
this value for 45-60 seconds.



Local Prefix

Enter any numbers you need to dial to get an outside line. Eclipse FAX will insert this string 
in front of your phone number if it determines that the call uses the same area code as 
entered in Current Area Code.
If you have call waiting, incoming calls can interrupt your fax transmissions. Most phone 
systems allow you to disable call waiting for one phone call by dialing either 1170 or *70 
before dialing the phone number. By entering the number to disable call waiting in the Dial 
Prefix field, you can make sure that the faxes you send do not get interrupted.



L.D. (Long Distance) Prefix

Enter any numbers you need to dial to get an outside long distance line. Eclipse FAX will 
insert this string in front of your phone number if it determines that the call does not use the
same area code as entered in Current Area Code. Do not enter an area code here; enter area
codes in the phone book, as part of the phone number.
If you have call waiting, incoming calls can interrupt your fax transmissions. Most phone 
systems allow you to disable call waiting for one phone call by dialing either 1170 or *70 
before dialing the phone number. By entering the number to disable call waiting in the Dial 
Prefix field, you can make sure that the faxes you send do not get interrupted.



Speaker

If fax connect tones annoy you, turn off the speaker. The default is "Until Connect" so you 
can hear problems (such as a wrong number). Click on the down arrow at the right of the 
speaker box to show a list of choices.



Speaker Volume

Click on the down arrow to show a list of volumes. Choose your preference.



Max. Retries

Enter the number of attempts you want Eclipse FAX to make when sending a fax.



Retry Time

Enter the number of seconds to wait between fax send attempts.



Max. TX Rate

Enter the maximum transmission rate for your faxes. Eclipse FAX automatically selects the 
maximum and minimum transmission rates whenever it sends a fax. You should only change
the rates if you have transmission problems.



Min. TX Rate

Enter the minimum transmission rate for your faxes. Eclipse FAX automatically selects the 
maximum and minimum transmission rates whenever it sends a fax. You should only change
the rates if you have transmission problems.



Home Area Code

Enter your home area code. When you send faxes to numbers in this area, you do not need 
to include the area code. If you do, Eclipse FAX automatically deletes the area code at 
transmission time. Leave this field and Current Area Code blank to disable the automatic 
phone number generation feature.



Current Area Code

Enter your current area code. (If you move your computer to another area code.) When 
Eclipse FAX sends a fax, numbers in your home area code will automatically include the area
code and numbers in the current area code will have the area code stripped off. Leave this 
field and Home Area Code blank to disable the automatic phone number generation feature.



From Name

Enter a name. Then click on the down arrow to choose a position on the banner (left, center, 
right, or none).



From Co.

Enter your company name, if any. Then click on the down arrow to choose a position on the 
banner (left, center, right, or none).



From Fax

Enter your fax number. Then click on the down arrow to choose a position on the banner 
(left, center, right, or none).



From Voice

Enter your voice phone number. Then click on the down arrow to choose a position on the 
banner (left, center, right, or none).



Station ID

Enter the electronic identification for your fax setup. (This will appear in both the recipient's 
and sender's logs.) Then click on the down arrow to choose a position on the banner (left, 
center, right, or none).



Page Number

Click on the down arrow to choose a position on the banner (left, center, right, or none).



Date/Time

Click on the down arrow to choose a position on the banner (left, center, right, or none).



To Name:

Click on the down arrow to choose the position of the recipient's name on the banner (left, 
center, right, or none).



To Co.:

Click on the down arrow to choose the position of the recipient's company on the banner 
(left, center, right, or none).



Modem...

Clicking on this button displays a dialog box    where you may enter an initialization string 
and an exit string. The initialization field may be used to activate flow control on your 
modem to minimize streaking on sent or received faxes.    Check in your fax modem 
documentation under Flow Control to find the correct string for your modem.    The XON/XOFF
and CTS (Clear To Send) check boxes tell Eclipse FAX in what mode of flow control your fax 
modem is operating. The README file may also contain more information on this topic.



The View Toolbar

 



The Edit Toolbar

 



The Thumbnail Toolbar

 



The OCR Toolbar

 



Displays View Toolbar.



Displays Edit Toolbar.



Displays Thumbnail Toolbar.



This is the page view button.



Sends the currently displayed fax.



Use left and right arrows to select a page to view. Page number appears in the Jump-to-Page 
button.



Clicking on Jump-to-Page to displays a dialog box; enter a page number and click on OK.



Use left and right arrows to display the desired four pages on the toolbar. Then click on the 
page number you want to view.



Click on one of these to rotate the page.



Displays faxes at approximately actual size. (default)



Displays the entire current page.



Displays two pages simultaneously. Also changes Jump-to-Page and Quick Page Selector so 
that you can view two non-consecutive pages on the screen at the same time!



Returns from a zoom.



Page forward quickly through your fax, a half-page at a time. There is a slight overlap on 
each page section to make sure you do not miss a line of your fax.



Page backward quickly through your fax, a half-page at a time. There is a slight overlap on 
each page section to make sure you do not miss a line of your fax.



Makes the fax easier to read, but slows the displaying of pages. To exit from ClearView click 
on the button again.



Undoes the last editing operation.



Reverses the last Undo.



Click on this tool, then select an area of the fax to magnify.



Converts the pointer to a freehand drawing tool.



Converts the pointer to a straight-line drawing tool.



Converts the pointer to an ellipse drawing tool.



Converts the pointer to an rectangle drawing tool.



Converts the pointer to a text tool. Click on the document and begin typing. Use the curved 
arrows on either side of the button to select a rotation angle for your text.



Displays list of fonts from which to choose.



Displays list of font sizes from which to choose.



Displays a Best-Fit view of a page that you select. (Click on Select Page, click on the desired 
page, and click on the  button at the far left of the toolbar.) You can also double click on 
the page using this tool. This method will always return you to the Best Fit view.



This tool allows you to make two pages to trade places by clicking and dragging the first 
page over the second.



Use this tool to merge two pages by clicking and dragging one page on top of another.



Moves an existing page to a new location by clicking and dragging. The other pages move 
down to make room for the inserted page.



Deletes the selected page(s). Select the page you wish to delete using the Select tool, then 
click on the Delete button (be sure the toolbar is displayed). You can choose multiple pages 
to delete by holding down the Control key and clicking on the pages you want to delete. A 
dialog box appears to confirm the deletion.



Merges multiple faxes into a single file.



Opens a text file.



Saves the contents of the Edit window.



Prints the contents of the Edit window to the current printer.



Undoes the last edit.



Removes the selected text and places it in the Windows clipboard.



Copies the selected text to the Windows clipboard.



Append selected text to the Windows clipboard.



Puts the contents of the clipboard in the Edit window.



Displays the Find dialog box.



Displays the Replace dialog box.



Halts the OCR process.



Mode
Choose from Fontelligent, Learned or Learning mode. Fontelligent mode will recognize most 
text using built-in tables. Learning mode allows you to 'teach' the program how to read a 
particular typeface. When recognizing text in Learning mode, the program will find letters 
and display a dialog box asking you to identify the character. These characters will be saved 
in a file for future use. If you OCR another document with the same typeface, you can use 
one of these tables by choosing Learned mode.



Language
Choose the language that best defines the character set used in the fax you want to OCR. 
Doing this will improve accuracy with foreign characters.



Unrecognized Character
This is the character inserted by Eclipse FAX when a letter cannot be identified. The default 
is '~'.



Automatic Column Recognition
If your document is formatted into multiple columns, you can avoid having to define each 
column as a zone by checking this box.



Retain Format
When this box is checked, the Eclipse FAX will insert carriage returns at the end of each line 
of OCR'd text to try to retain it's original format. If left unchecked, Eclipse FAX will only insert
carriage returns when a paragraph is detected.



Edit Window
When this button is clicked, text recognized by Eclipse FAX will be placed in the Edit window. 
Text can then be edited and saved in a variety of formats.



File
Recognized text will be saved in file. You will be asked to choose a file name and format. If 
you have chosen to Launch an application, this file will be opened when the application is 
started.



Clipboard
Recognized text will be pasted to the Windows clipboard. If you have checked the Launch 
box, the application you have entered will be started. You can then paste the clipboard to a 
document in the newly opened application. 



Launch
Checking this box will start any application listed in the Program box after the OCR process is
complete. Be sure the path and program name are correctly entered, or the application will 
not start (use the Browse button to locate files if you are unsure of the correct path; you can 
find an explanation on how to use the Browse button directly below this topic).

If used in conjunction with the File button, the file generated will be opened. If used with 
Clipboard, a blank document will appear.



Browse
Use this button to locate programs for use with Launch. A standard File dialog box will 
appear; simply locate the program you want to use. Clicking OK will paste the path and 
program name in the Program box.



When filling out the registration card, don't forget to include the serial number, which is 
found on the first page of your manual. Please return the completed registration card as 
soon as possible. Registering your program provides several benefits:

Only registered users get unlimited customer support.

We can answer your questions more effectively if your system configuration is on file.

You will be notified of any enhancements or upgrades.




